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1.1 Introduction

1 Observer User's Guide

1.1 Introduction
1.1.1 Scope

The Observer application is a container including the following tools for tracing and investigation of distributed
systems:

e Observer
e  Trace Tool Builder
e FErlang Top

e Crashdump Viewer

1.1.2 Prerequisites

It is assumed that the reader is familiar with the Erlang programming language.

1.2 Observer

1.2.1 Introduction

Observer isagraphical tool for observing the characteristics of Erlang systems. Observer displays system information,
application supervisor trees, processinformation, ETStables, Mnesiatablesand containsafront end for Erlang tracing.

1.2.2 Getting Started
Run Observer from a standal one node to minimize the impact of the system being observed.

Example:

% erl -sname observer -hidden -setcookie MyCookie -run observer

Select the node to observe with menu Nodes. Menu View > Refresh interval controls how often the view is to be
updated. The refresh interval is set per viewer so you can have different settings for each viewer. To minimize the
system impact, only the active viewer is updated. Other views are updated when activated.

The mouse buttons behave as expected. Use left-click to select objects, right-click to get a menu with the most used
options, and double-click to display information about the selected object. In most viewers with many columns, you
can change the sort order by |eft-clicking the column header.

1.2.3 System Tab

Tab System displays general information about the active Erlang node and its runtime system, such as build
configuration, system capabilities, and overall use statistics.

1.2.4 Load Charts Tab

Tab Load Chartsdisplays graphs of the current resource use on the active Erlang node.
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Graph Schedul er Utilizati on showsscheduler use per scheduler, where each scheduler use hasaunique color.

Graph Menory Usage showsthetotal memory use and per memory category use, where each category has aunique
color. The categories are as follows:

Tot al

The sum of al memory categories.
Processes

The sum of al process memory used.

At om

The size used by the atom table.
Bi nary

The sum of al off-heap binaries allocated.
Code

The memory allocated for code storage.
Ets

The used memory for all ETStables.
Graph | O Usage showsthe current 1/0 load on the system.

1.2.5 Memory Allocators Tab

Tab Memory Allocators displays detailed information of the carrier size and current memory carriers. For details
about memory carriers, ssemoduleert s_al | oc in application ERTS.

TheMax Carrier si ze column showsthe maximum value seen by observer since the last node change or since
the start of the application, i.e. switching nodes will reset the max column. Values are sampled so higher values may
have existed than what is shown.

1.2.6 Applications Tab

Tab Applications presents application information. Select an application in the left list to display its supervisor tree.
Theright-click optionsin the tree are as follows:

Processinfo

Opens a detailed information window on the selected process, including the following:
Process Information

Shows the process information.
Messages

Shows the process messages.
Dictionary

Shows the process dictionary.
Stack Trace

Shows the process current stack trace.
State

Shows the process state.
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Log
If enabled and available, shows the process SASL log entries.
Trace process
Adds the selected process identifier to tab Trace Overview plus the node that the process resides on.
Trace named process

Adds the registered name of the process. This can be useful when tracing on many nodes, as processes with that
name are then traced on all traced nodes.

Trace process tree
Adds the selected process and all processes below, right of it, to tab Trace Overview.
Trace named process tree

Adds the selected process and all processes below, right of it, to tab Trace Overview.

1.2.7 Processes Tab
Tab Processes lists process information in columns. For each process the following information is displayed:
Pid
The process identifier.
Reds

The number of reductions executed on the process. This can be presented as accumulated values or as values
since the last update.

Memory

The size of the process, in bytes, obtained by acall topr ocess_i nf o( Pi d, nenory).
MsgQ

The length of the message queue for the process.

Option Process info opens a detailed information window on the process under the mouse pointer, including the
following:

Process Information

Shows the process information.
Messages

Shows the process messages.
Dictionary

Shows the process dictionary.
Stack Trace

Shows the process current stack trace.
State

Shows the process state.
Log

If enabled and available, shows the process SASL log entries.
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L og requires application SASL to be started on the observed node, with| og_nf _h aslog handler. The Observed
node must be Erlang/OTP R16B02 or higher. Ther b server must not be started on the observed node when clicking
menu L og > Togglelogview. Ther b server isstopped on the observed node when exiting or changing the observed
node.

Option Trace selected processes adds the selected process identifiers to tab Trace Overview plus the node that the
processes reside on.

Option Trace selected processes by name adds the registered name of the processes. This can be useful when tracing
is done on many nodes, as processes with that name are then traced on all traced nodes.

Option Kill process brutally kills the processes under the mouse pointer by sending an exit signal with reasonki | | .

1.2.8 Ports Tab
Tab Portslists port information in columns. For each port the following information is displayed:
Id

The port identifier.
Connected

The process identifier for the process that owns the port.
Name

The registered name of the port, if any.
Controls

The name of the command set by er | ang: open_port/ 2.
Slot

Theinternal index of the port.

Option Port info opens a detailed information window for the port under the mouse pointer. In addition to the
information above, it also shows links and monitors.

Option Trace selected ports adds the selected port identifiers, and the nodes that the ports reside on, to tab Trace
Overview.

Option Trace selected ports by name adds the registered name of the port to tab Trace Overview. This can be useful
when tracing is done on many nodes, as ports with that name are then traced on all traced nodes.

Option Close executeser | ang: port _cl ose/ 1 on the port under the mouse pointer.

1.2.9 Table Viewer Tab

Tab Table Viewer liststables. By default, ETStables are displayed whereas unreadable private ETS tables and tables
created by OTP applications are not diplayed. Use menu View to view "system" ETS tables, unreadable ETS tables,
or Mnesiatables.

Double-click to view the table content, or right-click and select option Show Table Content. To view table
information, select thetable and activate menu View > Tableinformation, or right-click and select option Tableinfo.

Y ou can use regular expressions and search for objects, and edit or delete them.
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1.2.10 Trace Overview Tab

Tab Trace Overview handlestracing. Trace by selecting the processes or portsto be traced and how to trace them. For
processes, you can trace messages, function calls, scheduling, garbage collections, and process-related events such as
spawn, exi t , and many others. For ports, you can trace messages, scheduling and port-related events.

To trace function calls, you also need to set up trace patterns. Trace patterns select the function calls to be traced.
The number of traced function calls can be further reduced with match specifications. Match specifications can also
be used to trigger more information in the trace messages.

Y ou can aso set match specifications on messages. By default, if tracing messages, all messages sent and/or received
by the process or port are traced. Match specifications can be used to reduce the number of traced messages and/or
to trigger more information in the trace messages.

Trace patterns only apply to the traced processes and ports. ‘

Processes are added from the Applications or Processes tabs. Ports are added from the Ports tab. A specia new
identifier, meaning all processes, or ports, started after trace start, can be added with buttons Add 'new' Processes
and Add 'new' Ports, respecively.

When adding processes or ports, awindow with trace optionsis displayed. The chosen options are set for the selected
processes/ports. To change the options, right-click the process or port and select Edit process options. To remove a
process or port from the list, right-click and select Remove process or Remove port, respectively.

Processes and ports added by process/port identifiers add the nodes these processes/ports reside on in the node list.
More nodes can be added by clicking button Add Nodes, or by right-clicking in the Nodes|list and select Add Nodes.
To remove nodes, select them, then right-click and choose Remove nodes.

If function calls are traced, trace patterns must be added by clicking button Add Trace Pattern. Select a module,
function(s), and a match specification. If no functions are selected, all functions in the module are traced.

Trace patterns can also be added for traced messages. Click button Add Trace Pattern and select M essages sent or
M essages r eceived, and a match specification.

A few basic match specifications are provided in the tool, and you can provide your own match specifications. The
syntax of match specifications is described in the ERTS User's Gui de. To simplify the writing of a match
specification, they can also be written asf un/ 1. For details, see module ms_transform in application STDLIB.

Click button Start Trace to start the trace. By default, trace output is written to a new window. Tracing is stopped
when the window is closed, or when clicking button Stop Trace. Trace output can be changed with menu Options >
Output. Thetrace settings, including match specifications, can be saved to, or loaded from, afile.

For detail sabout tracing, see module dbg in application Runtime_Toolsand in section "Match specificationsin Erlang"
inERTS User's Qui de andinmodulens_t r ansf or min application STDLIB.

1.3 Trace Tool Builder
1.3.1 Introduction

Trace Tool Builder is a base for building trace tools for single node or distributed Erlang systems. It requires the
Runtime_Tools application to be available on the traced node.

The following are the main features of Trace Tool Builder:

«  Start tracing to file ports on many nodes with one function call.
e Write moreinformation to atrace information file, which is read during formatting.
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» Restore previous configuration by maintaining a history buffer and handling configuration files.
*  Provide some simple support for sequential tracing.
* Format binary trace logs and merge logs from multiple nodes.

The intention of Trace Tool Builder isto serve as a base for tailor-made trace tools, but it can also be used directly
from the Erlang shell (it can mimic dbg behaviour while still providing useful additions, such as match specification
shortcuts). Trace Tool Builder only alows the use of file port tracer, so to use other types of trace clients it is better
to use dbg directly.

1.3.2 Getting Started

Modulet t b istheinterfaceto all functionsin Trace Tool Builder.

To get started, the least you need to do isto start atracer witht t b: t racer/ 0, 1, 2, and set therequired trace flags
on the processes you want to tracewitht t b: p/ 2.

When the tracing is completed, stop the tracer with ttb:stop/0,1 and format the trace log with
ttb: format/ 1, 2 (if thereisanything to format).

Useful functions:
ttb:tracer/0,1, 2

Opens a trace port on each node to be traced. By default, trace messages are written to binary files on remote
nodes (the binary trace log).

tth:p/2

Specifies the processes to be traced. Trace flags specified in this call specify what to trace on each process. This
function can be called many timesif you like different trace flags to be set on different processes.

tth:tp/2,3,4orttbh:tpl/2,3,4

If youwant to trace function calls (that is, if you havetraceflagcal | set onany process), you must also set trace
patterns on the required function(s) withtt b: tp/ 2, 3,4 orttb: tpl/ 2, 3, 4. A function is only traced if
it has atrace pattern. The trace pattern specifies how to trace the function by using match specifications. Match
specifications are described in the ERTS User's Guide.

ttb:stop/0,1
Stops tracing on all nodes, deletes all trace patterns, and flushes the trace port buffer.
tth:format/1/2

Trandates the binary trace logs into something readable. By default, t t b presents each trace message as aline
of text, but you can aso write your own handler to make more complex interpretations of the trace information.
A trace log can also be presented graphically with application Event Tracer (ET).

If option f or mat isspecifiedtott b: st op/ 1, the formatting is automatically done when stoppingt t b.

Tracing Local Node from Erlang Shell

The following small module is used in the subsequent example:

-module(m).
-export([f/01).
O ->
receive
From when is pid(From) ->
Now = erlang:now(),
From ! {self(),Now}
end.
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The following example shows the basic use of t t b from the Erlang shell. Default options are used both for starting
the tracer and for formatting (the custom fetch directory is however provided). This gives a trace log named Node-
t t b in the newly created directory, where Node is the node name. The default handler prints the formatted trace
messages in the shell:

(tiger@durin)47> %% First I spawn a process running my test function
(tiger@durin)47> Pid = spawn(m,f,[]).

<0.125.0>

(tiger@durin)48>

(tiger@durin)48> %% Then I start a tracer...

(tiger@durin)48> ttb:tracer().

{ok, [tiger@durin]}

(tiger@durin)49>

(tiger@durin)49> %% and activate the new process for tracing
(tiger@durin)49> %% function calls and sent messages.
(tiger@durin)49> ttb:p(Pid, [call,send]).

{ok, [{<0.125.0>, [{matched, tiger@durin,1}]}1}

(tiger@durin)50>
(tiger@durin)50>
(tiger@durin)50>

)

) Here I set a trace pattern on erlang:now/0

)
(tiger@durin)50>

)

)

)

The trace pattern is a simple match spec
indicating that the return value should be
traced. Refer to the reference manual for
(tiger@durin)50> the full list of match spec shortcuts
(tiger@durin)50> available.

(tiger@durin)51> ttb:tp(erlang,now, return).

{ok, [{matched, tiger@durin, 1}, {saved, 1}1}

(tiger@durin)52>

(tiger@durin)52> %% I run my test (i.e. send a message to
(tiger@durin)52> %% my new process)

(tiger@durin)52> Pid ! self().

<0.72.0>

(tiger@durin)53>

(tiger@durin)53> %% And then I have to stop ttb in order to flush
(tiger@durin)53> %% the trace port buffer

(tiger@durin)53> ttb:stop([return, {fetch dir, "fetch"}]).
{stopped, "fetch"}

(tiger@durin)54>

(tiger@durin)54> %% Finally I format my trace log
(tiger@durin)54> ttb:format("fetch").
({<0.125.0>,{m,f,0},tiger@durin}) call erlang:now()
({<0.125.0>,{m,f,0},tiger@durin}) returned from erlang:now/0 ->
{1631,133451,667611}

({<0.125.0>,{m,f,0},tiger@durin}) <0.72.0> !
{<0.125.0>,{1031,133451,667611}}

ok

Build Your Own Tool

The following example shows a simple tool for "debug tracing”, that is, tracing of function calls with return values:

(tiger@durin)50>

o o° o o o of
o® o® o° o° o° o°
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-module(mydebug) .
-export([start/0,trc/1,stop/0,format/1]).
-export([print/41]).
%% Include ms transform.hrl so that I can use dbg:fun2ms/2 to
%% generate match specifications.
include lib("stdlib/include/ms_transform.hrl").

%%% ------------- Tool API-------------

%%% Star the "mydebug" tool

start() ->
%% The options specify that the binary log shall be named
%% <Node>-debug log and that the print/4 function in this
%% module shall be used as format handler

ttb:tracer(all, [{file, "debug log"}, {handler, {{?MODULE,print},03}}1]),
%% ALl processes (existing and new) shall trace function calls

%% We want trace messages to be sorted upon format, which requires
%% timestamp flag. The flag is however enabled by default in ttb.
ttb:p(all,call).

%%% Set trace pattern on function(s)

trc(M) when is atom(M) ->
tre({M,"_",'_'});

trc({M,F}) when is atom(M), is atom(F) ->
trc({M,F,"'_'});

trc({M,F, A}=MFA) when is atom(M), is atom(F) ->
%% This match spec shortcut specifies that return values shall
%% be traced.
MatchSpec = dbg:fun2ms(fun(_ ) -> return_trace() end),
ttb:tpl(MFA,MatchSpec).

%%% Format a binary trace log
format(Dir) ->
ttb:format(Dir).

%%% Stop the "mydebug" tool
stop() ->
ttb:stop(return).

%%% -------- Internal functions--------
%%

C= 2= T
%%% Format handler

print( Out,end of trace, TI,N) ->
N;

print(Out,Trace, TI,N) ->
do print(Out,Trace,N),
N+1.

do print(Out,{trace ts,P,call,{M,F,A},Ts},N) ->
io:format(Out,
"~w: ~w, ~w:~n"
"Call Do~Wi~W/~w~n"
"Arguments :~p~n~n",
[N,Ts,P,M,F,length(A),A]);
do print(Out,{trace ts,P,return_ from,{M,F,A},R,Ts},N) ->
io:format(Out,
"~w: ~w, ~w:~n"
"Return from : ~w:~w/~w~n"
"Return value :~p~n~n",
[N,Ts,P,M,F,A,R]).

To distinguish trace logs produced with this tool from other logs, optionfi | e isusedintracer/ 2. Thelogsare
therefore fetched to adirectory namedt t b_upl oad_debug_| og- YYYYMVDD- HHMVBS
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By using option handl er when starting the tracer, the information about how to format the file is stored in the trace
informationfile(. t i ). Thisisnot necessary, asit can be specified when formatting instead. However, It can be useful
if you, for example, want to format trace logs automatically using option f or mat int t b: st op/ 1. Also, you do not
need any knowledge of the content of abinary log to format it the way it isintended. If option handl er is specified
both when starting the tracer and when formatting, the one specified when formatting is used.

Trace flag cal | is set on all processes. This means that any function activated with command t r ¢/ 1 istraced on
all existing and new processes.

1.3.3 Running Trace Tool Builder against Remote Node

The Observer application might not always be available on the node to be traced (in the following called the "traced
node"). However, Trace Tool Builder can still be run from another node (in the following called the "trace control
node") as long as the following is fulfilled:

e The Observer application is available on the trace control node.

e TheRuntime_Tools application is available on both the trace control node and the traced node.

If Trace Tool Builder isto be used against aremote node, it is highly recommended to start the trace control node as
hidden. Thisway it can connect to the traced node without being "seen” by it, that is, if thenodes() BIF iscalled

on the traced node, the trace control node does not show. To start a hidden node, add option - hi dden to theer |
command, for example:

% erl -sname trace control -hidden

Diskless Node

If the traced node is diskless, t t b must be started from a trace control node with disk access, and option f i | e must
be specified to functiont r acer / 2 withvalue{| ocal , Fil e}, for example:

(trace control@durin)l> ttb:tracer(mynode@diskless,
{file,{local, {wrap, "mytrace"}}}).
{ok, [mynode@diskless]}

1.3.4 More Tracing Options
When setting up atrace, the following features can aso be activated:

e Time-constrained tracing
*  Overload protection

e Autoresume

* dbg mode

Time-Constrained Tracing

It can sometimes be helpful to enable trace for a specified period of time (for example, to monitor a system for 24
hours or half a second). This can be done with option {ti mer, Ti mer Spec}. If Ti ner Spec has the form of
MBec, thetraceis stopped after MSec millisecondsusingt t b: st op/ 0. If more options are provided (Ti ner Spec
= {Msec, Opts}),tth:stop/1liscaledinstead with Opt s asargument.

Thetimer isstarted witht t b: p/ 2, so any trace patternsmust be set upinadvance.t t b: start _trace/ 4 aways
sets up al patterns before invokingt t b: p/ 2.

The following example shows how to set up atrace that is automatically stopped and formatted after 5 seconds:
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(tiger@durin)1> ttb:start trace([node()],
[{erlang, now,[]1}],
{all, call},
[{timer, {5000, format}}]).

| Because of network and processing delays, the period of tracing is approximate. |

Overload Protection

When tracing live systems, always take special care to not overload a node with too heavy tracing. tt b provides
option over | oad to address this problem.

{overl oad, MsSec, Mbdul e, Functi on} instructsthet t b back end (apart of the Runtime_Toolsapplication)
to perform overload check every Msec millisecond. If the check (named Modul e: Functi on( check) ) returns
t r ue, tracing is disabled on the selected node.

Overload protection activated on one node does not affect other nodes, where the tracing continues as normal.
tth: stop/0, 1 fetches data from al clients, including everything collected before the activation of overload
protection.

Itisnot allowed to changetracedetails (witht t b: pandttb: t p/t pl .. .)onceoverload protectionisactivated
in one of the traced nodes. Thisisto avoid trace setup being inconsistent between nodes.

Modul e: Funct i on provided with option over | oad must handle three calls: i ni t, check, and st op.i ni t
and st op alow some setup and teardown required by the check. An overload check module can look as follows:

-module(overload).
-export([check/1]).

check(init) ->
Pid = sophisticated module:start(),
put(pid, Pid);
check(check) ->
get(pid) ! is overloaded,
receive
Reply ->
Reply
after 5000 ->
true
end;
check(stop) ->
get(pid) ! stop.

check isaways called by the same process, so put and get are possible.

Autoresume

A node can crash (probably a buggy one, hence traced). Use r esun®e to resume tracing on the node automatically
when it gets back. The failing node then tries to reconnect to trace control node when Runt i ne_Tool s is started.
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Thisimpliesthat Runt i me_Tool s must beincluded in the startup chain of other nodes (if not, you can still resume
tracing by starting Runt i me_Tool s manually, that is, by an RPC call).

To not losethe datathat the failing node stored up to the point of crash, the control nodetriesto fetchit beforerestarting
trace. This must occur within the allowed time frame, otherwise it is aborted (default is 10 seconds, but it can be
changed with { r esune, MsSec} ). The datafetched thisway isthen merged with all other traces.

The autostart feature requires more data to be stored on traced nodes. By default, the data is stored automatically
to the file named "ttb_autostart.bin” in the currect working directory (cwd) of the traced node. Users can change
this behaviour (that is, on diskless nodes) by specifying their own module to handle autostart data storage and
retrieval (t t b_aut ost art _nodul e environment variableof r unt i me_t ool s). For information about the AP,
seemodulet t b. The following example shows the default handler:

-module(ttb autostart).

-export([read config/0,
write config/1,
delete config/0]).

-define (AUTOSTART FILENAME, "ttb autostart.bin").

delete config() ->
file:delete(?AUTOSTART FILENAME).

read config() ->
case file:read file(?AUTOSTART FILENAME) of
{ok, Data} -> {ok, binary to term(Data)};
Error -> Error
end.

write config(Data) ->
file:write file(?AUTOSTART FILENAME, term to binary(Data)).

Remember that file trace ports buffer the data by default. If the node crashes, trace messages are not flushed to the
binary log. If therisk of failureis high, it can be agood ideato flush the buffers every now and then automatically.
Passing { f | ush, MSec} asanoptionofttb:tracer/ 2 flushesall buffers every Msec millisecond.

dbg Mode

Option{shel | , Shel | Type} alowsmakingtt b operation similar to dbg. Using{shel | , true} displays
all trace messagesin the shell before storing them. { shel | , onl y} additionally disables message storage (making
the tool to behave exactly like dbg). Thisisalowed only with IPtraceports({trace, {local, File}}).

Commandttb:tracer (dbg) isashortcut for the puredbg mode ({ shel | , onl y}).

1.3.5 Trace Information and File .ti

In addition to the trace log file(s), afile with extension . t i is created when Trace Tool Builder is started. Thisisthe
traceinformation file. It isabinary file, which contains the processinformation, trace flags used, the name of the node
to which it belongs, and all information written with functiont t b: wite_trace_info/ 2..ti filesareaways
fetched with other logs when the trace is stopped.

Except for the process information, everything in the trace information file is passed on to the handler function when
formatting. Parameter Tl isalist of { Key, Val ueLi st} tuples. The keysf| ags, handl er,fil e, and node
are used for information written directly by t t b.
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Information to the trace information file by can be added by callingttb: wite_trace_i nfo/ 2. Notice that
Val uelLi st aways is a list, and if you call wite_trace_i nfo/2 many times with the same Key, the
Val uelLi st isextended with anew value each time.

Example:

ttb:wite_trace_info(nykey, 1) gives the entry {nykey,[1]} in TI. Another cal,
ttb:wite_trace_info(nykey, 2),changesthisentry to{nykey, [1, 2] }.

1.3.6 Wrap Logs

If you want to limit the size of the trace logs, you can use wrap logs. Thisworks almost like acircular buffer. You can
specify the maximum number of binary logs and the maximum size of each log. t t b then creates a new binary log
each time alog reaches the maximum size. When the maximum number of logs are reached, the oldest log is deleted
before anew oneis created.

The overall size of data generated by t t b can be greater than the wrap specification suggests. If a traced node
restarts and autoresume is enabled, the old wrap log is always stored and a new one s created.

Wrap logs can be formatted one by one or all at once. See Formatting.

1.3.7 Formatting

Formatting can be done automatically when stopping t t b (see section Automatically Collect and Format Logs from
All Nodes), or explicitly by calling functiont t b: format/ 1, 2.

Formatting means to read a binary log and present it in a readable format. Y ou can use the default format handler in
t t b to present each trace message as aline of text, or write your own handler to make more complex interpretations
of the trace information. Y ou can aso use application ET to present the trace log graphically (see section Presenting
Trace Logs with Event Tracer).

The first argument tot t b: f or mat / 1, 2 specifies which binary log(s) to format. This is usually the name of a
directory that t t b created during log fetch. Unless option di sabl e_sort isprovided, the logs from different files
are always sorted according to time-stamp in traces.

The second argument tot t b: f or mat / 2 isalist of options asfollows:
out

Specifies the destination to write the formatted text. Default destination is st andar d_i o, but a filename can
aso be specified.

handl er

Specifiestheformat handler to use. If thisoption isnot specified, option handl er that is specified when starting
the tracer is used. If option handl er is not specified when starting the tracer either, a default handler is used,
which prints each trace message as atext line.

di sabl e_sort

Indicates that the logs are not to be merged according to time-stamp, but processed one file after another (this
can be abit faster).

A format handler isafuntaking four arguments. Thisfuniscalled for each trace messagein the binary log(s). A smple
example that only prints each trace message can be as follows:
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fun(Fd, Trace, TraceInfo, State) ->
io:format(Fd, "Trace: ~p~n", [Trace]),
State

end.

Here, Fd isthefile descriptor for thedestination file, or theatomst andar d_i o. _Tr acel nf o containsinformation
from the trace information file (see section Trace Information and File .ti). St at e is a state variable for the format
handler fun. Theinitia value of variable St at e is specified with the handler option, for example:

ttb:format("tiger@durin-ttb", [{handler, {{Mod,Fun}, initial state}}])

AAAAAAAAAAAAA

Another format handler can be used to calcul ate the time spent by the garbage collector:

fun( Fd,{trace ts,P,gc start, Info,StartTs}, TraceInfo,State) ->

[{P,StartTs}|State];
(Fd,{trace ts,P,gc _end, Info,EndTs}, TraceInfo,State) ->

{value, {P,StartTs}} = lists:keysearch(P,1,State),
Time = diff(StartTs,EndTs),
io:format("GC in process ~w: ~w milliseconds~n", [P,Time]),
State -- [{P,StartTs}]

end

A more refined version of this format handler is function handl e_gc/ 4 inmodulerrul titrace. erl included
in directory sr ¢ of the Observer application.

The trace message is passed as the second argument (Tr ace). The possible values of Tr ace are the following:

e All trace messages describediner | ang: trace/ 3
e {drop, N} iflIPtracerisused (seedbg:trace_port/2)
« end_of _trace received once when al trace messages are processed

By giving the format handler t t b: get _et _handl er (), you can have the trace log presented graphically with
et _vi ewer inthe ET application (see section Presenting Trace Logs with Event Tracer).

You can always decide not to format the whole trace data contained in the fetch directory, but analyze single files
instead. To do so, asinglefile (or list of files) must be passed as the first argument tof or mat / 1, 2.

Wrap logs can be formatted one by one or all at once. To format one of the wrap logs in a set, specify the exact file
name. To format the whole set of wrap logs, specify the name with * instead of the wrap count.

Example:
Start tracing:

(tiger@durin)1l> ttb:tracer(node(),{file, {wrap,"trace"}}).
{ok, [tiger@durin]}
(tiger@durin)2> ttb:p(...)

This gives a set of binary logs, for example:
tiger@durin-trace.0.wrp

tiger@durin-trace.l.wrp
tiger@durin-trace.2.wrp

Format the whole set of logs:
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1> ttb:format("tiger@durin-trace.*.wrp").
ok
2>

Format only thefirst log:

1> ttb:format("tiger@durin-trace.0.wrp").
ok
2>

To merge all wrap logs from two nodes:

1> ttb:format(["tiger@durin-trace.*.wrp","lion@durin-trace.*.wrp"]).
ok
2>

Presenting Trace Logs with Event Tracer
For detailed information about the Event Tracer, see the ET application.

By giving the format handler t t b: get _et _handl er (), you can have the trace log presented graphically with
et _vi ewer intheET application. t t b providesfiltersthat can be selected fromthe menu Filter intheet _vi ewer
window. The filters are names according to the type of actors they present (that is, what each vertical line in the
sequence diagram represents). Interaction between actors is shown as red arrows between two vertical lines, and
activities within an actor are shown as blue text to the right of the actors line.

Thepr ocesses filteristheonly filter showing all trace messages from atracelog. Each vertical linein the sequence
diagram represents a process. Erlang messages, spawn, and link/unlink are typical interactions between processes.
Function calls, scheduling, and garbage collection, are typical activities within a process. pr ocesses isthe default
filter.

The remaining filters only show function calls and function returns. All other trace message are discarded. To get
the most out of thesefilters, et _vi ewer must know the caller of each function and the time of return. This can be
obtained using both the cal | and r et ur n_t o flags when tracing. Notice that flag r et ur n_t o only works with
local call trace, that is, when trace patterns are set witht t b: t pl .

The same result can be obtained by using the flag cal | only and setting a match specification on local or global
function calls asfollows:

1> dbg:fun2ms(fun(_) -> return trace(),message(caller()) end).
[{'" ",[1,[{return_trace},{message,{caller}}]}]

This must however be done with care, as function {ret urn_trace} in the match specification destroys tail
recursiveness.

Thenodul es filter shows each module as avertical linein the sequence diagram. External function callg/returns are
shown as interactions between modules, and internal function calls/returns are shown as activities within amodule.

The f unct i ons filter shows each function as a vertical line in the sequence diagram. A function calling itself is
shown as an activity within afunction, and all other function calls are shown as interactions between functions.

Thenods_and_procs andf uncs_and_pr ocs filters are equivalent to the modul es and f unct i ons filters
respectively, except that each module or function can have many vertical lines, one for each process it resides on.

In the following example, modulesf oo and bar are used:
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-module(foo).

-export([start/0,90/0]).

start() ->

spawn (?MODULE, go, []).

go() ->
receive
stop ->
ok;
go ->
bar:
go()
end.

-module(bar).

f10),

-export([fl/0,f3/01).

f1() ->
f2(),
ok.

f2() ->

spawn(?MODULE, f3,[]).

f3() ->
ok.

Setting up the trace:

(tiger@durin)1>
(tiger@durin)1>
(tiger@durin)2>
(tiger@durin)2>
(tiger@durin)3>
(tiger@durin)4>
(tiger@durin)5>
(tiger@durin)5>
(tiger@durin)6>

Thisrenders aresult

%%First we retrieve the Pid to limit traced processes set
Pid = foo:start().

%%Now we set up tracing

ttb:tracer().

ttb:p(Pid, [call, return to, procs, set on spawn]).
ttb:tpl(bar, [1).

%%Invoke our test function and see output with et viewer
Pid ! go.

ttb:stop({format, {handler, ttb:get et handler()}}).

similar to the following:
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el_viewer (filter: processes)

File ¥iewer Collector Filter Help

i Freeze Detail Lewvel

i Hide From=Tao
i Hide Unknown

<0, 327, 0% <0.331. 0=

tigarédurin tigarédurin
call bar: £1/0
call bar: £2/0

apawn bar: £3/0

L
r

raturn to bar: £150

raturn to foo:gosl

axit

call bar: £3/70

return to undafinad

axlt

Figure 3.1: Filter: "processes"
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el_viewer (filter: mods_and procs)

File ¥iewer Collector Filter Help

.§ Freeze Detail Lewvel

i Hide From=To
_i Hide Unknown i3

100

Eoo bar bar
<0, 227, 0> <0, 227, 0> <0, 221, 0>

tigard8durin tigard8durin tigardurin
gElca.ll bar: £1/0 e ==

L.
.

call bar: £2/0

raturn to bar: £150

raturn to foo:gosi
o

zall bar: £3/0

raturn to unkncwn

Figure 3.2: Filter: "mods_and_procs"
Notice that functiontt b: st art _t r ace/ 4 can be used as help asfollows:

(tiger@durin)1l> Pid = foo:start().
(tiger@durin)2> ttb:start trace([node()],
[{bar,[1}1,
{Pid, [call, return_to, procs, set on_spawn]}
{handler, ttb:get et handler()}).
(tiger@durin)3> Pid ! go.
(tiger@durin)4> ttb:stop(format).

1.3.8 Automatically Collect and Format Logs from All Nodes

By default, t t b: st op/ 1 fetches trace logs and trace information files from al nodes. The logs are stored in a new
directory named t t b_upl oad- Fi | enane- Ti mest anp under the working directory of the trace control node.
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Fetching can be disabled by providing option nof et ch tot t b: st op/ 1. The user can specify afetch directory by
passing option{fetch_dir, Dir}.

If option f or mat isspecifiedtott b: st op/ 1, thetrace logs are automatically formatted after tracing is stopped.

1.3.9 History and Configuration Files

For the tracing functionality, dbg can be used instead of t t b for setting trace flags on processes and trace patterns
for call trace, that is, the functionsp, t p, t pl , ct p, ct pl , and ct pg. Only the following two things are added by
t t b for these functions:

» All cdlsare stored in the history buffer and can be recalled and stored in a configuration file. This makesiit
easy to set up the same trace environment, for example, if you want to compare two test runs. It also reduces the
amount of typing when using t t b from the Erlang shell.

»  Shortcuts are provided for the most common match specifications (to not force you to use dbg: f un2ns
continually).

Usetthb:list_history/ 0 to seethe content of the history buffer and t t b: r un_hi st ory/ 1 to re-execute
one of the entries.

The main purpose of the history buffer isthe possibility to create configuration files. Any function stored in the history
buffer can be written to a configuration file and used for creating a specific configuration at any time with a single
function call.

A configuration fileis created or extended witht t b: wri t e_confi g/ 2, 3. Configuration filesare binary filesand
can therefore only be read and written with functions provided by t t b.

The complete content of the history buffer can be written to a configuration file by caling
ttb:wite config(ConfigFile,all). Selected entries from the history can be written by caling
ttb:wite_config(ConfigFile, Nuni st), where NurlLi st isalist of integers pointing out the history
entries to write. Moreover, the history buffer isawaysdumpedtott b _| ast _confi gwhenttb: stop/0, 1is
called.

User-defined  entries can aso be written to a  configuration file by  caling
function ttb:wite_config(ConfigFile, ConfigList), where ConfigList is a list of
{ Modul e, Functi on, Args}.

Any existing file Confi gFil e is deleted and a new file is created when write_confi g/ 2 is caled.
Option append can be used to add something at the end of an existing configuration file, for example,
ttb:wite_config(ConfigFile, Wiat, [append]).

Example:
See the content of the history buffer:

(tiger@durin)191> ttb:tracer().

{ok, [tiger@durin]}

(tiger@durin)192> ttb:p(self(),[garbage collection,calll).
{ok,{[<0.1244.0>], [garbage collection,calll}}
(tiger@durin)193> ttb:tp(ets,new,2,[1).

{ok, [{matched,1}]1}

(tiger@durin)194> ttb:list history().

[{1,{ttb,tracer, [tiger@durin, [11}},
{2,{ttb,p,[<0.1244.0>, [garbage collection,calll]l}},
{3,{ttb,tp, [ets,new,2,[]11}}]

Execute an entry from the history buffer:
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(tiger@durin)195> ttb:ctp(ets,new,2).

{ok, [{matched,1}]1}

(tiger@durin)196> ttb:list history().
[{1,{ttb,tracer,[tiger@durin, []]1}},

{2,{ttb,p, [<0.1244.0>, [garbage collection,call]]}},
{3,{ttb,tp,[ets,new,2,[]11}},
{4,{ttb,ctp,[ets,new,2]1}}]

(tiger@durin)197> ttb:run_history(3).

ttb:tp(ets,new,2,[]) ->

{ok, [{matched,1}]1}

Write the content of the history buffer to a configuration file:

(tiger@durin)198> ttb:write config("myconfig",all).
ok

(tiger@durin)199> ttb:list config("myconfig").
[{1,{ttb,tracer,[tiger@durin, [11}},
{2,{ttb,p,[<0.1244.0>, [garbage collection,callll}},
{3,{ttb,tp, [ets,new,2,[]11}},

{4,{ttb,ctp, [ets,new,2]}},

{5,{ttb,tp, [ets,new,2,[]11}}]

Extend an existing configuration:

(tiger@durin)200> ttb:write config("myconfig", [{ttb,tp, [ets,delete,1,[]1]}],
[append]) .
ok
(tiger@durin)201> ttb:list config("myconfig").
[{1,{ttb,tracer,[tiger@durin, [11}},
{2,{ttb,p,[<0.1244.0>, [garbage collection,calll]}},
{3,{ttb,tp, [ets,new,2,[]11}},
{4,{ttb,ctp, [ets,new,2]}},
{5,{ttb,tp, [ets,new,2,[]11}},
{6,{ttb,tp, [ets,delete,1,[]1]1}}]

Go back to a previous configuration after stopping Trace Tool Builder:
(tiger@durin)202> ttb:stop().
ok
(tiger@durin)203> ttb:run config("myconfig").
ttb:tracer(tiger@durin,[]) ->
{ok, [tiger@durin]}

ttb:p(<0.1244.0>, [garbage collection,call]) ->
{ok,{[<0.1244.0>], [garbage collection,call]}}

ttb:tp(ets,new,2,[]) ->
{ok, [{matched,1}]1}

ttb:ctp(ets,new,2) ->
{ok, [{matched,1}1}

ttb:tp(ets,new,2,[]) ->
{ok, [{matched, 1}]1}

ttb:tp(ets,delete,1,[]) ->
{ok, [{matched,1}1}

ok
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Write selected entries from the history buffer to a configuration file:

(tiger@durin)204> ttb:list history().
[{1,{ttb,tracer,[tiger@durin, [11}},

{2,{ttb,p, [<0.1244.0>, [garbage collection,call]]}},
{3,{ttb, tp, [ets,new,2,[1]}},

{4,{ttb,ctp, [ets,new,2]}},
{5,{ttb, tp, [ets,new,2,[1]}},

{6,{ttb, tp, [ets,delete,1,[]1]}}]

(tiger@durin)205> ttb:write config("myconfig",[1,2,3,6]).
ok

(tiger@durin)206> ttb:list config("myconfig").
[{1,{ttb,tracer,[tiger@durin, [11}},

{2,{ttb,p, [<0.1244.0>, [garbage collection,call]]}},
{3,{ttb, tp, [ets,new,2,[1]}},

{4,{ttb, tp, [ets,delete,1,[]1]}}]

(tiger@durin)?207>

1.3.10 Sequential Tracing
To learn what sequential tracing is and how it can be used, see the Reference Manual for seq_t r ace.
The support for sequentia tracing provided by Trace Tool Builder includes the following:

« Initiation of the system tracer. Thisis automatically done when atrace port is started with
ttb:tracer/0,1, 2.

»  Creation of match specifications that activates sequential tracing.

Starting sequential tracing requires that a tracer is started with functiont t b: tracer/ 0, 1, 2. Sequential tracing
can then be started in either of the following ways:

»  Through atrigger function with a match specification created witht t b: seq_t ri gger _ns/ 0, 1.
« Directly by using moduleseq_t race.

Example 1:
In the following example, function dbg: get _t racer/ 0 isused astrigger for sequential tracing:

(tiger@durin)110> ttb:tracer().

{ok, [tiger@durin]}

(tiger@durin)111> ttb:p(self(),call).

{ok,{[<0.158.0>],[call]}}

(tiger@durin)112> ttb:tp(dbg,get tracer,0,ttb:seq trigger ms(send)).
{ok, [{matched, 1}, {saved,1}1}

(tiger@durin)113> dbg:get tracer(), seq trace:reset trace().

true

(tiger@durin)114> ttb:stop(format).
({<0.158.0>,{shell,evaluator,3},tiger@durin}) call dbg:get tracer()
SeqTrace [0]: ({<0.158.0>,{shell,evaluator,3},tiger@durin})
{<0.237.0>,dbg,tiger@durin} ! {<0.158.0>,{get tracer,tiger@durin}}
[Serial: {0,1}]

SeqTrace [0]: ({<0.237.0>,dbg,tiger@durin})

{<0.158.0>, {shell,evaluator,3},tiger@durin} ! {dbg, {ok,#Port<0.222>}}
[Serial: {1,2}]

ok

(tiger@durin)116>

Example 2:
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Starting sequential tracing with atrigger is more useful if the trigger function is not called directly from the shell, but
rather implicitly within alarger system. When calling afunction from the shell, it is simpler to start sequential tracing
directly, for example, asfollows:

(tiger@durin)116> ttb:tracer().

{ok, [tiger@durin]}

(tiger@durin)117> seq trace:set token(send,true), dbg:get tracer(),
seq_trace:reset trace().

true

(tiger@durin)118> ttb:stop(format).

SeqTrace [0]: ({<0.158.0>,{shell,evaluator,3},tiger@durin})
{<0.246.0>,dbg, tiger@durin} ! {<0.158.0>,{get tracer,tiger@durin}}
[Serial: {0,1}]

SeqTrace [0]: ({<0.246.0>,dbg,tiger@durin})

{<0.158.0>, {shell,evaluator,3},tiger@durin} ! {dbg, {ok,#Port<0.229>}}
[Serial: {1,2}]

ok

(tiger@durin)120>

In both previous examples, seq_trace: reset _trace/ 0 resets the trace token immediately after the traced
function to avoid many trace messages because of the printoutsin the Erlang shell.

All functionsin moduleseq_t r ace, except set _system tracer/ 1, can be used after the trace port is started
withttb:tracer/0, 1, 2.

1.3.11 Multipurpose Trace Tool

Module rmul titrace in directory src of the Observer application provides a small tool with three
possible trace settings. The trace messages are written to binary files, which can be formatted with function
mul titrace:format/1, 2:

nmul titrace: debug(What)

Start calltrace on all processes and trace the specified function(s). The format handler used is
mul titrace: handl e_debug/ 4 that printseach call and returns. What must be an item or alist of itemsto
trace, specified on the format { Modul e, Functi on, Ari ty},{ Modul e, Functi on}, or only Mbdul e.

mul titrace: gc(Procs)

Trace garbage collection on the specified process(es). The format handler used is
mul titrace: handl e_gc/ 4 that prints start, stop, and the time spent for each garbage collection.

mul titrace: schedul e(Procs)

Trace in-scheduling and out-scheduling on the specified process(es). The format handler used is
mul titrace: handl e_schedul e/ 4 that prints each in-scheduling and out-scheduling with process, time-
stamp, and current function. It also prints the total time each traced process was scheduled in.

1.4 Erlang Top
1.4.1 Introduction

Erlang Top, et op, isatool for presenting information about Erlang processes similar to the information presented
by t op in UNIX.

1.4.2 Getting Started
Start Erlang Top in either of the following ways:
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* Usescript et op.
« Usebatchfileet op. bat , for example, et op - node tiger @luri n.

1.4.3 Output

The output from Erlang Top is as follows:

tiger@durin 13:40:32
Load: cpu 0 Memory: total 1997 binary 33
procs 197 processes 0 code 173
runqg 135 atom 1002 ets 95
Pid Name or Initial Func Time Reds Memory MsgQ Current Function
<127.23.0> code_server 0 59585 78064 0 gen_server:loop/6
<127.21.0> file server 2 0 36380 44276 0 gen server:loop/6
<127.2.0> erl prim loader 0 27962 3740 0 erl prim_ loader:loop
<127.9.0> kernel sup 0 6998 4676 0 gen_server:loop/6
<127.17.0> net kernel 62 6018 3136 0 gen_server:loop/6
<127.0.0> init 0 4156 4352 0 init:loop/1
<127.16.0> auth 0 1765 1264 0 gen_server:loop/6
<127.18.0> inet tcp dist:accept 0 660 1416 0 prim inet:accept0/2
<127.5.0> application controll 0 569 6756 0 gen_server:loop/6
<127.137.0> net kernel:do spawn 0 553 5840 0 dbg:do relay 1/1

The header includes some system information:
Load
cpu
Runt i ne/ Wl | ¢l ock, that is, the percentage of time where the node has been active.
procs
The number of processes on the node.
rung
The number of processes that are ready to run.
Menory
The memory allocated by the node in kilobytes.
For each process the following information is presented:
Ti me
The runtime for the process, that is, the time that the process has been scheduled in.
Reds
The number of reductions executed on the process.
Menory
The size of the process in bytes, obtained by acall to pr ocess_i nf o( Pi d, nenory).
MsgQ
The length of the message queue for the process.
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Time and Reds can be presented as accumulated values or as values since the last update.

1.4.4 Configuration

All configuration parameters can be set at start by adding - Opt Nane Val ue to the command line, for example:

% etop -node tiger@durin -setcookie mycookie -lines 15

A list of all valid Erlang Top configuration parametersis available in module et op.

The parameters | i nes, i nterval , accunul at e, and sort can be changed during runtime with function
et op: confi g/ 2.

Example:

Change configuration parameter | i nes with text-based presentation. Before the change, 10 lines are presented as
follows:

tiger@durin 10:12:39
Load: cpu 0 Memory: total 1858 binary 33
procs 191 processes 0 code 173
rung 2 atom 1002 ets 95
Pid Name or Initial Func Time Reds Memory MsgQ Current Function
<127.23.0> code server 0 60350 71176 0 gen server:loop/6
<127.21.0> file server 2 0 36380 44276 0 gen server:loop/6
<127.2.0> erl prim loader 0 27962 3740 0 erl prim loader:loop
<127.17.0> net kernel 0 13808 3916 0 gen server:loop/6
<127.9.0> kernel sup 0 6998 4676 0 gen server:loop/6
<127.0.0> init 0 4156 4352 0 init:loop/1
<127.18.0> inet tcp dist:accept 0 2196 1416 0 prim inet:accept0/2
<127.16.0> auth 0 1893 1264 0 gen server:loop/6
<127.43.0> ddll server 0 582 3744 0 gen server:loop/6
<127.5.0> application controll 0 569 6756 0 gen server:loop/6

Function et op: confi g/ 2 iscaled to change the number of showed linesto 5:
> etop:config(lines,5).
ok

After the change, 5 lines are presented as follows:
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(etop@durin)2>
tiger@durin 10:12:44
Load: cpu 0 Memory: total 1859 binary 33
procs 192 processes 0 code 173
rung 2 atom 1002 ets 95
Pid Name or Initial Func Time Reds Memory MsgQ Current Function
<127.17.0> net kernel 183 70 4092 0 gen_server:loop/6
<127.335.0> inet tcp dist:do acc 141 22 1856 0 dist util:con loop/9
<127.19.0> net kernel:ticker/2 155 6 1244 0 net kernel:tickerl/2
<127.341.0> net _kernel:do spawn_ 0 0 5840 0 dbg:do relay 1/1
<127.43.0> ddll server 0 0 3744 0 gen_server:loop/6

1.4.5 Print to File
At any time, the current Erlang Top display can be dumped to atext file with function et op: dunp/ 1.

1.4.6 Stop

To stop Erlang Top, use function et op: st op/ 0.

1.5 Crashdump Viewer

1.5.1 Introduction
The Crashdump Viewer is a WxWidgets based tool for browsing Erlang crashdumps.

1.5.2 Getting Started

The easiest way to start Crashdump Viewer is to use shell script cdv with the full path to the Erlang crashdump as
argument. The script islocated in directory pr i v of the Observer application. This starts the Crashdump Viewer GUI
and loads the specified file. If no filename is specified, afile dialog is opened where the file can be selected.

Under Windows, the batch file cdv. bat can be used.

Crashdump Viewer can aso be started from an Erlang node by caling crashdump_viewer:start/O or
crashdump_viewer:start/1.

1.5.3 GUI

The GUI main window is opened when Crashdump Viewer has loaded a crashdump. It contains a title bar, a menu
bar, information tabs, and a status bar.

The title bar shows the name of the currently loaded crashdump.

The menu bar contains a File menu and a Help menu. From the File menu, a new crashdump can be loaded or the
tool can be terminated. From the Help menu, this User's Guide and section "How to interpret the Erlang crash dumps®
from the ERTS application can be opened. "How to interpret the Erlang crash dumps" describes the raw crashdumps
in detail and includesinformation about each field in the information pages."How to interpret the Erlang crash dumps’
is also available in the OTP online documentation.

The status bar at the bottom of the window shows awarning if the currently loaded dump is truncated.

The center area of the main window contains the information tabs. Each tab displays information about a specific item
or alist of items. Select atab by clicking the tab title.
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From tabs displaying lists of items, for example, the Processes tab or the Ports tab, a new window with more
information can be opened by double-clicking arow or by right- clicking the row and selecting an item from the drop-
down menu. The new window is called a detail window. Detail windows can be opened for processes, ports, nodes,
and modules.

The information shown in a detail window can contain links to processes or ports. Clicking one of these links opens
the detail window for the process or port in question. If the process or port resides on aremote node, no information is
available. Clicking thelink then displays adialog where you can choose to open the detail window for the remote node.

Some tabs contain a left-hand menu where subitems of the information area can be selected. Click one of the rows,
and the information is displayed in the right-hand information area.

1.5.4 Tab Content

Each tab in the main window contains an information page. If no information is found for an item, the page is empty.
The reason for not finding information about an item can be the following:

e Itisadump from an old OTP release in which thisitem was not written.
e Theitem was not present in the system at the point of failure.
*  Thedump istruncated. In this case, awarning is displayed in the status bar of the main window.

Evenif someinformation about an item exists, there can be empty fieldsif the dump originatesfroman old OTPrelease.

The value - 1 in any field means "unknown", and in most cases it means that the dump was truncated somewhere
around thisfield.

The following sections describe some of the fields in the information tabs. These are fields that do not exist in the
raw crashdump, or in some way differ from the fields in the raw crashdump. For details about other fields, see the
ERTS User's Guide, section "How to interpret the Erlang crash dumps'. That section can aso be opened from the
Help menu in the main window. There are also links from the following sections to related information in "How to
interpret the Erlang crash dumps".

1.5.5 General Tab
Tab General shows a short overview of the dump.
The following fields are not described in the ERTS User's Guide:
Crashdunp created on

Time of failure.
Menmory al | ocat ed

The total number of bytes allocated, equivalenttoc: menory(total ).
Menmory maxi mum

The maximum number of bytes that has been allocated during the lifetime of the originating node. Thisis only
shown if the Erlang runtime system is run instrumented.

At ons

If available in the dump, this is the total number of atoms in the atom table. If the size of the atom table is
unavailable, the number of atoms visible in the dump is displayed.

Processes

The number of processes visiblein the dump.
ETS tabl es

The number of ETS tables visible in the dump.
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Funs
The number of funs visible in the dump.

For details, see General Information in section "How to Interpret the Erlang Crash Dumps® in ERTS.

1.5.6 Processes Tab

Tab Processes shows alist of all processes found in the crashdump, including brief information about each process.
By default, the processes are sorted by their pids. To sort by another topic, click the desired column heading.

Column Memory shows the ‘Memory' field that was added to crashdumps in Erlang/OTP R16B01. This is the total
amount of memory used by the process. For crashdumps from earlier releases, this column shows the 'Stack+heap'
field. Thevalueisawaysin bytes.

To view detailed information about a specific process, double- click the row in the list, or right-click the row and
select Propertiesfor <pid>.

For details, see Process Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.7 Ports Tab

Tab Portsis similar to the Processes tab, except it lists all ports found in the crashdump.

Toview moredetail sabout aspecific port, double-click therow or right-click it and select Propertiesfor <port>. From
the right-click menu, you can also select Propertiesfor <pid>, where <pi d> isthe process connected to the port.

For details, see Port Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.8 ETS Tables Tab

Tab ETS Tables shows all ETS table information found in the dump. Id is the same as the 'Table' field in the raw
crashdump. Memory is the 'Words' field from the raw crashdump translated into bytes. For tree tables, there is no
value in the 'Objects field.

To open the detailed information page about the table, double- click, or right-click the row and select Properties for
'l dentifier'.

To open the detailed information page about the owner process of an ETS table, right-click the row and select
Propertiesfor <pid>.

For details, see ETS Tables in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.9 Timers Tab

Tab Timer s shows all timer information found in the dump.

To open the detailed information page about the owner process of atimer, right-click the row and select Properties
for <pid>.

Double-clicking arow in the Timer s tab has no effect.
For details, see Timersin section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.10 Schedulers Tab
Tab Scheduler s shows all scheduler information found in the dump.

To open the detailed information page about the scheduler, double-click, or right-click the row and select Properties
for 'l dentifier'.
For details, see Scheduler Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.
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1.5.11 Funs Tab

Tab Funs shows all fun information found in the dump.

To open the detailed information page about the module to which the fun belongs, right-click the row and select
Propertiesfor <mod>.

Double-clicking arow in the Funstab has no effect.
For details, see Fun Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.12 Atoms Tab

Tab Atomslists al atoms found in the dump. By default the atoms are sorted in creation order from first to last. This
is opposite of the raw crashdump where atoms are listed from last to first, meaning that if the dump was truncated in
the middle of the atom list, only the last created atoms are visible in the Atoms tab.

For details, see Atomsin section "How to Interpret the Erlang Crash Dumps" in ERTS.

1.5.13 Nodes Tab
Tab Nodes shows alist of all external Erlang nodes that are referenced from the crashdump.

If the page is empty, it means either of the following:

¢ The crashed nodeis not distributed.
* The crashed node is distributed but has no references to other nodes.
e Thedumpistruncated.

If the node is distributed, all referenced nodes are visible. Column Connection type shows if the node is visible,
hidden, or not connected. Visible nodes are alive nodes with aliving connection to the originating node. Hidden nodes
are the same as visible nodes, except they are started with flag - hi dden. Not connected nodes are nodes that are not
connected to the originating node anymore, but references (that is, process or port identifiers) exist.

To see more detailed information about a node, double-click the row, or right-click the row and select Propertiesfor
node <node>. From the right-click menu, you can also select Propertiesfor <port>, to open the detailed information
window for the controlling port.

In the detailed information window for a node, any existing links and monitors between processes on the originating
node and the connected node are displayed. Extra Info can contain debug information (that is, special information
written if the emulator is debug-compiled) or error information.

For details, see Distribution Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.14 Modules Tab

Tab Modules lists all modules loaded on the originating node, and the current code size. If old code exists, the old
sizeis aso shown.

To view detailed information about a specific module, double- click the row, or right-click it and select Properties
for <mod>.

For details, see Loaded Module Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.15 Memory Tab

Tab Memory shows memory and allocator information. From the left-hand menu you can select the following:
Memory
See Memory Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.
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Allocator Summary

This page presents a summary of values from al allocators underneath it.
<Allocator>

One entry per alocator. See Allocator in section "How to Interpret the Erlang Crash Dumps' in ERTS.
Allocated Areas

See Allocated Areasin section "How to Interpret the Erlang Crash Dumps' in ERTS.

1.5.16 Internal Tables Tab
Ontab Internal Tablesyou can from theleft-hand menu select Hash Tables, Index Tables, or Internal ETS Tables.
For details, see Internal Table Information in section "How to Interpret the Erlang Crash Dumps' in ERTS.
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2 Reference Manual
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Application

The Observer application contains tools for tracing and investigation of distributed systems.

Configuration

No configuration parameters are available for this application.
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observer

Erlang module

Observer is a graphical tool for observing the characteristics of Erlang systems. The tool Observer displays system
information, application supervisor trees, process information, ETS tables, Mnesiatables, and contains afront end for
Erlang tracing with modulet t b.

For details about how to get started, seethe User ' s CGui de.

Exports

start() -> ok
Starts the Observer GUI. To stop the tool, close the window.
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ttb

Erlang module

The Trace Tool Builder, t t b, isabase for building trace tools for distributed systems.
When using t t b, do not use module dbg in application Runtime_Toolsin parallel.

Exports

start trace(Nodes, Patterns, FlagSpec, Opts) -> Result
Types:

Result = see p/2

Nodes = see tracer/2

Patterns = [tuple()]

Fl agSpec = {Procs, Fl ags}

Proc = see p/2

Fl ags = see p/2

Opts = see tracer/2
This function is a shortcut allowing to start a trace with one command. Each tuple in Pat t er ns is converted to a
list, whichinturnispassedtott b: t pl /2, 3, 4.

Thecall:

> ttb:start trace([Node, OtherNode],
[{mod, foo, [1}, {mod, bar, 2}],
{all, call},
[{file, File}, {handler,{fun myhandler/4, S}}1).

isequivalent to:

> ttb:start trace([Node, OtherNode],
[{file, File}, {handler,{fun myhandler/4, S}}1),
ttb:tpl(mod, foo, [1),
ttb:tpl(mod, bar, 2, [1),
ttb:p(all, call).

tracer() -> Result
Equivalenttot racer (node()).

tracer(Shortcut) -> Result
Types:
Shortcut = shell | dbg
Handy shortcuts for common tracing settings.
shel | isequivalenttotracer(node(),[{file, {local, "ttb"}}, shell]).
dbg isequivaenttot racer (node(), [{shell, only}]).

32 | Ericsson AB. All Rights Reserved.: Observer



tth

tracer(Nodes) -> Result
Equivalenttot r acer ( Nodes, []) .

tracer(Nodes,Opts) -> Result

Types:
Result = {ok, ActivatedNodes} | {error, Reason}
Nodes = atom() | [atonm()] | all | existing | new

Opts = Opt | [Opt]

Opt = {file,Cient} | {handler, FormatHandl er} | {process_info,Pl} |
shell | {shell, ShellSpec} | {timer, TimerSpec} | {overload_check, {Msec,
Modul e, Function}} | {flush, Msec} | resume | {resune, FetchTi neout} |
{queue_si ze, QueueSi ze}

Ti mer Spec = Msec | {Msec, StopOpts}

MSec = FetchTi meout = integer()

Modul e = Function = atom()

StopOpts = see stop/2

Client = File | {local, File}

File = Filenane | Wap

Fil ename = string()

Wap = {wap, Filenane} | {wap, Fil enane, Si ze, Count }

For mat Handl er = See format/2

Pl =true | false

Shel | Spec = true | false | only

QueueSi ze = non_neg_i nteger ()
Starts afile trace port on al specified nodes and points the system tracer for sequential tracing to the same port.
Options:
Fi | enane

The specified Fi | enarme is prefixed with the node name. Default Fi | enane istt b.
Fil e={wrap, Fi | enane, Si ze, Count }

Can be used if the size of the trace logs must be limited. Default values are Si ze=128* 1024 and Count =8.
Cient

When tracing diskless nodes, t t b must be started from an external "trace control node" with disk access, and
Client mustbe{l ocal, File}.All traceinformation is then sent to the trace control node where it is
written to file.

queue_si ze

Whentracingtoshell or { | ocal , Fi | e}, aniptracedriver isused internally. Theip trace driver has a queue of
maximum QueueSi ze messages waiting to be delivered. If the driver cannot deliver messages as fast as they
are produced, the queue size might be exceeded and messages are dropped. This parameter is optional, and is
only useful if many { dr op, N} trace messages are received by the trace handler. It has no meaning if shell or
{l ocal , Fi | e} isnot used. See dbg:trace_port/2 for more information about the ip trace driver.
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process_info

Indicatesif processinformationisto becollected. If PI = t r ue (which isdefault), each processidentifier Pi d
isreplaced by atuple{ Pi d, Processl nf o, Node}, where Pr ocess| nf o is the registered process name,
its globally registered name, or itsinitial function. To turn off this functionality, set PI = f al se.

{shell, Shell Spec}

Indicates that trace messages are to be printed on the console as they are received by the tracing process. This
impliestraceclient {1 ocal , Fil e}.If Shel | Spec isonl y (instead of t r ue), no trace logs are stored.

shel |
Shortcut for { shel I, true}.
timer

Indicates that the trace is to be automatically stopped after MSec milliseconds. St opOpt s are passed to
commandtt b: st op/ 2 if specified (default is[ ] ). Notice that the timing is approximate, as delays related to
network communication are aways present. The timer starts after t t b: p/ 2 isissued, so you can set up your
trace patterns before.

overl oad_check

Allowsto enable overload checking on the nodes under trace. Modul e: Funct i on( check) isperformed each
MBec millisecond. If the check returnst r ue, thetracing is disabled on a specified node.

Modul e: Funct i on must be able to handle at least three atoms: i ni t, check, and st op.i nit and st op
alows you to initialize and clean up the check environment.

When a node gets overloaded, it is not possible toissuet t b: p/ 2 or any command fromthettb: tp/ 2, 3, 4
family, asit would lead to inconsistent tracing state (different trace specifications on different nodes).

flush

Periodically flushes al file trace port clients (seedbg: f 1 ush_t race_port/ 1). When enabled, the buffers
are freed each Msec millisecond. This option isnot allowed with{fil e, {local, File}} tracing.

{resune, FetchTi nmeout}

Enables the autoresume feature. When enabled, remote nodes try to reconnect to the controlling node if they are
restarted. The feature requires application Runtime_Tools to be started (so it has to be present in the . boot
scriptsif the traced nodes run with embedded Erlang). If thisis not possible, resume can be performed manually
by starting Runt i ne_Tool s remotely usingr pc: cal | / 4.

tt b tries to fetch all logs from a reconnecting node before reinitializing the trace. This must finish within
Fet chTi meout milliseconds or is aborted.

By default, autostart information is stored in afile named tt b_aut ost art . bi n on each node. If this is
not desired (for example, on diskless nodes), a custom module handling autostart information storage and
retrieval can be provided by specifying environment variablett b_aut ost art _nodul e for the application
Runtime_Tools. The module must respond to the following API:

wite_config(Data) -> ok

Stores the provided data for further retrieval. It is important to realize that the data storage used must not
be affected by the node crash.

read_config() -> {ok, Data} | {error, Error}
Retrieves configuration stored withwri t e_confi g(Dat a) .
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del ete_config() -> ok

Deletes configuration stored withwr i t e_conf i g( Dat a) . Noticethat after thiscall any subsequent calls
toread_configmustreturn{error, Error}.

r esune impliesthe default Fet chTi nmeout , which is 10 seconds

p(Item,Flags) -> Return

Types:
Return = {ok,[{Item Mat chDesc}]}
Items = Item| [lten]
Item= pid() | port() | RegNane | {global, d obal RegNane} | all | processes

| ports | existing | existing_processes | existing ports | new
new_processes | new_ports

RegNanme = atom()
G obal RegNane = term()
Flags = Flag | [Fl ag]

Sets the specified trace flags on the specified processes or ports. Flagt i mest anp isalways turned on.

Seethe Reference Manual for module dbg for the possible trace flags. Parameter Mat chDesc isthe same asreturned
fromdbg: p/ 2.

Processes can be specified asregistered names, globally registered names, or process identifiers. Ports can be specified
as registered names or port identifiers. If aregistered name is specified, the flags are set on processes/ports with this
name on all active nodes.

Issuing this command starts the timer for thistraceif optiont i ner isspecifiedwitht racer/ 2.

tp(Module [, Function [, Arity]], MatchSpec)
tp({Module, Function , Arity}, MatchSpec)
tpl(Module [, Function [, Arity]], MatchSpec)
tpl({Module, Function , Arity}, MatchSpec)
ctp()

ctp(Module [, Function [, Arityl])
ctp({Module, Function, Arity})

ctpl()

ctpl(Module [, Function [, Arity]])
ctpl({Module, Function, Arity})
ctpg()

ctpg(Module [, Function [, Arityll])

ctpg({Module, Function, Arity})
tpe(Event,MatchSpec)
ctpe(Event)

These functions are to be used with traceflag cal | , send, and' r ecei ve' for setting and clearing trace patterns.

When trace flag cal | is set on a process, function calls are traced on that process if a trace pattern is set for the
called function

Thesend and' recei ve' flagsenabletracing of all messages sent and received by the process/port. Trace patterns
set with t pe may limit traced messages based on the message content, the sender, and/or the receiver.
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Trace patterns specify how to trace a function or a message by using match specifications. Match specifications are
described inthe ERTS User' s QGui de.

These functions are equivalent to the corresponding functions in module dbg, but all calls are stored in the history.
The history buffer makes it easy to create configuration files; the same trace environment can be set up many times,
for example, to compare two test runs. It also reduces the amount of typing when usingt t b from the Erlang shell.

tp
Sets trace patterns on global function calls.
t pl
Sets trace patterns on local and global function calls.
t pe
Sets trace patterns on messages.
ctp
Clearstrace patterns on local and global function calls.
ctpl
Clearstrace patterns on local function calls.
ct pg
Clearstrace patterns on global function calls.
ct pe
Clears trace patterns on messages.

With t p and t pl , one of the match specification shortcuts can be used (for example, tt b: t p(f oo_nodul e,
caller)).

The shortcuts are as follows:

e return-for[{" _",[],[{return_trace}]}] (reportthereturnvaluefrom atraced function)
e caller -for[{" _",[],[{ressage,{caller}}]}] (reportthe calling function)

e {codestr, Str} -fordbg: fun2ns/ 1 argumentspassed as strings (example: "fun(_) ->
return_trace() end")

list history() -> History
Types:
H story = [{N, Func, Args}]

All callstott b isstored in the history. This function returns the current content of the history. Any entry can be
reexecuted with r un_hi st ory/ 1 or stored in aconfiguration filewithwr i t e_confi g/ 2, 3.

run_history(N) -> ok | {error, Reason}
Types:
N = integer() | [integer()]
Executes the specified entry or entries from the history list. Tolist history, usel i st _hi st ory/ 0.

write config(ConfigFile,Config)
Equivalenttowr i te_confi g(ConfigFile, Config,[]).
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write config(ConfigFile,Config,Opts) -> ok | {error,Reason}
Types.
ConfigFile = string()

Config = all | [integer()] | [{Mod, Func, Args}]
Mod = atom()

Func = atom()

Args = [tern()]

Opts = Opt | [Opt]

Opt = append

Creates or extends a configuration file, which can be used for restoring a specific configuration later.

The contents of the configuration file can either be fetched from the history or specified directly as a list of
{Mod, Func, Args}.

If the complete history is to be stored in the configuration file, Conf i g must be al | . If only a selected nhumber of
entries from the history are to be stored, Conf i g must be alist of integers pointing out the entries to be stored.

If Opt s isnot specified or if itis[], Confi gFi | e isdeleted and anew fileis created. If Opt s = [ append],
Conf i gFi | e isnot deleted. The new information is appended at the end of thefile.

run_config(ConfigFile) -> ok | {error,Reason}
Types.
ConfigFile = string()

Executes all entries in the specified configuration file. Notice that the history of the last trace is always available in
filettb_l ast _config.

run_config(ConfigFile,NumList) -> ok | {error,Reason}
Types:
ConfigFile = string()
NumlLi st = [integer()]
Executes selected entries from the specified configuration file. NunLi st isalist of integers pointing out the entries
to be executed.
To list the contents of a configuration file, usel i st _confi g/ 1.

Notice that the history of the last traceis always availableinfilet t b_I| ast _confi g.

list config(ConfigFile) -> Config | {error,Reason}
Types:

ConfigFile = string()

Config = [{N, Func, Args}]
Listsall entriesin the specified configuration file.

write trace info(Key,Info) -> ok
Types.
Key = term)
Info = Data | fun() -> Data
Data = term))
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File. ti contains{ Key, Val ueLi st} tuples. Thisfunction adds Dat a to the Val ueLi st associated with Key.
All information written with this function isincluded in the call to the format handler.

seq _trigger ms() -> MatchSpec
Equivalenttoseq_trigger _ns(all).

seq trigger ms(Flags) -> MatchSpec

Types:
Mat chSpec = mat ch_spec()
Flags = all | SeqTraceFlag | [SeqTraceFl ag]

SeqTraceFl ag = atom()

A match specification can turn on or off sequential tracing. This function returns a match specification, which turns
on sequential tracing with the specified Fl ags.

This match specification can be specified as the last argument to t p or t pl . The activated | t emthen becomes a
trigger for sequential tracing. This means that if theitem is called on a process with trace flag cal | set, the process
is"contaminated" with tokenseq_t r ace.

If Fl ags = al |, all possible flags are set.
The possible valuesfor SeqTr aceFl ag areavailableinseq_tr ace.

For adescription of the mat ch_spec() syntax, see section Mat ch Specifications in ErlanginERTS,
which explains the general match specification "language”.

The system tracer for sequential tracing is automatically initiated by tt b when a trace port is started with
ttb:tracer/0,1, 2.

An example of how to use functionseq_t ri gger _ns/ 0, 1 follows:

(tiger@durin)5> ttb:tracer().

{ok, [tiger@durin]}

(tiger@durin)6> ttb:p(all,call).

{ok, {[all], [call]l}}

(tiger@durin)7> ttb:tp(mod, func,ttb:seq trigger ms()).
{ok, [{matched, 1}, {saved,1}1}

(tiger@durin)8>

Whenever nod: func(. ..) iscalled after this, token seq_t r ace is set on the executing process.

stop()
Equivalenttost op([1]) -

stop(Opts) -> stopped | {stopped, Dir}

Types:
Opts = Opt | [Opt]
Opt = nofetch | {fetch_dir, Dir} | format | {format, FornmatQpts} |
return_fetch_dir

Dir = string()
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Format Opts = see format/2

Stops tracing on al nodes. Logs and trace information files are sent to the trace control node and stored in a directory
named tt b_upl oad_Fi | eName- Ti mest anp, where Fi | enane is the one provided with {file, File}
during trace setup and Ti mest anp isof theformyyyynmdd- hhmrss. Even logs from nodes on the same machine
as the trace control node are moved to this directory. The history list issaved to afilenamedttb_| ast _confi g
for further reference (as it is no longer accessible through history and configuration management functions, like
ttb:list_history/0).
Options:
nof et ch

Indicates that trace logs are not to be collected after tracing is stopped.
{fetch, Dir}

Allows specification of the directory to fetch the datato. If the directory already exists, an error isthrown.
f or mat

Indicates the trace logs to be formatted after tracing is stopped. All logs in the fetch directory are merged.
return_fetch dir

Indicatesthereturn valueto be { st opped, Dir} andnotjust st opped. Thisimpliesf et ch.

get et handler()
Returnsthe et handler, which can beused withf ornat/ 2 ort racer/ 2.
Example:ttb: format (Dir, [{handler, tth:get et handler()}]).

format(File)
Equivalenttof ormat (Fil e, []).

format(File,Options) -> ok | {error, Reason}
Types:
File = string() | [string()]
This can be the name of abinary log, alist of such logs, or the name of adirectory containing one or more
binary logs.
Options = Opt | [Opt]
Opt = {out,CQut} | {handl er, Format Handl er} | di sable_sort
Qut = standard_io | string()
For mat Handl er = {Function, Initial State}
Function = fun(Fd, Trace, Tracel nfo, State) -> State
Fd = standard_io | FileDescriptor
File descriptor of the destination file Qut .
Trace = tuple()
The trace message. For details, see the Reference Manual for module er | ang.
Tracel nfo = [{Key, Val uelLi st}]

Includesthe keysf | ags, cl i ent, and node. If handl er isspecified as option to the tracer function, thisis
also included. Also, al information written with functionwr i t e_t race_i nf o/ 2 isincluded.
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Reads the specified binary trace log(s). The logs are processed in the order of their time stamps as long as option
di sabl e_sort isnot specified.

If Format Handl er = {Function, I nitial State},Functi on iscalledfor each trace message.

If For mat Handl er = get_et _handl er (), et_vi ewer in application ET is used for presenting the trace
log graphicaly. tt b provides a few different filters that can be selected from menu Filters and scaling in the
et _viewer.

If For mat Handl er isnot specified, adefault handler is used presenting each trace message as atext line.

The state returned from each call of Funct i on ispassed to the next call, even if the next call isto format a message
from ancther log file.

If Qut isspecified, For mat Handl er getsthe file descriptor to Qut asthefirst parameter.
Qut isignored if theet format handler is used.

Wrap logs can be formatted one by one or all at once. To format one of the wrap logs in a set, specify the exact file
name. To format the whole set of wrap logs, specify the name with * instead of the wrap count. For examples, see
theUser's Cui de.
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etop

Erlang module

Start Erlang Top with the provided scripts et op. This starts a hidden Erlang node that connects to the node to be
measured. The measured node is specified with option - node. If the measured node has a different cookie than the
default cookie for the user who invokes the script, the cookie must be explicitly specified with option - set cooki e.

Under Windows, batch fileet op. bat can be used.

When executing the et op script, configuration parameters can be specified as command-line options, for example,
etop -node testnode@vyhost -setcookie MyCookie. Thefollowing configuration parameters exist
for the tool:

node
The measured node.
Vaue: at om()
Mandatory
set cooki e
Cookie to use for the et op node. Must be same as the cookie on the measured node.
Value: at on()
l'ines
Number of lines (processes) to display.
Vaue: i nt eger ()
Default: 10
i nterval
Timeinterval (in seconds) between each update of the display.
Value: i nt eger ()
Default: 5
accumul at e
If t r ue, the execution time and reductions are accumul ated.
Value: bool ean()
Default: f al se
sort
I dentifies what information to sort by.
Vaue runtime | reductions | nmenory | nsg_(
Default: runt i ne (r educti ons if t raci ng=of f)
tracing

et op uses the Erlang trace facility, and thus no other tracing is possible on the measured node while et op is
running, unless thisoption is set to of f . Also helpful if the et op tracing causes too high load on the measured
node. With tracing off, runtime is not measured.

Vaue:on | off
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Default: on
For details about Erlang Top, see the User's Guide.

Exports

start() -> ok
Startset op. Notice that et op is preferably started with the et op script.

start(Options) -> ok
Types:
Options = [ Option]
Option = {Key, Val ue}
Key = atom()
Val ue = term()
Startset op. To view the possible options, use hel p/ 0.

help() -> ok
Displaysthe help of et op and its options.

config(Key,Value) -> Result

Types:
Result = ok | {error, Reason}
Key = lines | interval | accunulate | sort

Value = term)

Changes the configuration parameters of the tool during runtime. Allowed parameters are | i nes, i nt erval ,
accumnul ate,andsort.

dump(File) -> Result

Types:
Result = ok | {error, Reason}
File = string()

Dumps the current display to atext file.

stop() -> stop
Terminates et op.
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crashdump_viewer

Erlang module

The Crashdump Viewer is a WxWidgets based tool for browsing Erlang crashdumps.
For details about how to get started with the Crashdump Viewer, seetheUser ' s Gui de.

Exports

start() -> ok
start(File) -> ok
Types:
File = string()
The filename of the crashdump.
Starts the Crashdump Viewer GUI and |oads the specified crashdump.

If Fi | e isnot specified, afile dialog is opened where the crashdump can be selected.

stop() -> ok
Terminates the Crashdump Viewer and closes all GUI windows.
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cdv

Command

The cdv shell script is located in directory pri v of the Observer application. The script is used for starting the
Crashdump Viewer tool from the OS command line.

For Windows users, cdv. bat isfound in the same location.

Exports
cdv [file]

Argument fi | e isoptional. If not specified, afile dialog is displayed, allowing you to select a crashdump from the
file system.
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